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Introduzione 
 

ExcelGetSDMXData è un plugin per Excel realizzato allo scopo di scaricare i dati dal 

Single Exit Point (SEP) dell’Istituto o di un qualsiasi altro data provider, che metta a 

disposizione i propri dati e/o metadati strutturali utilizzando come sistema di 

diffusione il Web Service della SDMX-RI di Eurostat e pensato per quei utenti che 

desiderano fare una analisi statistica dei dati e che sono soliti utilizzare Excel.  

L’applicativo offre inoltre altre funzionalità come la possibilità di salvare i dati  richiesti, 

in formato CSV ed in formato SDMX e la possibilità di salvare la DSD ad essi associata. 

Il documento si articola in due principali sezioni.  

• La prima nella quale sono elencati i requisiti minimi richiesti ed i passi da 

eseguire per una corretta installazione dell’applicativo.  

• Nella seconda sono descritti i passi tutte le maschere (GUI) e le funzionalità che 

compongono l’applicativo.  

Pre-Requisiti 

 

Per l’installazione dell’applicativo sono necessari i seguenti requisiti hardware e 

software 

 

Desktop or Laptop Recommended Specifications: 

Processore Intel Pentium 4 OR 

AMD Athlon 64 OR 

AMD Duron family OR 

2.8 GHz equivalent 

Memoria 500 MB 

Hard Drive 300 MB free space 

Sistema Operativo Windows XP Professional 

Risoluzione video 1280x1024 

.NET Framework .NET Framework 4.0 

Tabella 1 - Pre-requisiti necessari per l’installazione del tool 

 

Installazione 
 

Il tool è fornito di apposito programma di installazione. Sarà quindi sufficiente lanciare 

il file Setup.exe e seguire le indicazioni di seguito riportate. 

 
Per installare l’applicativo sulla propria macchina è sufficiente eseguire i seguenti passi: 



 

 

• Scompattare il file .zip contentente il programma di installazione scaricato dal 

sito web e fare click sull’icona setup.exe (Figura 1) con il tasto destro del 

mouse e selezionare la voce di menu “Esegui come…”  per eseguire il 

programma con un utente che ha i privilegi di amministratore. Quindi 

confermare l’avvio della procedura di installazione guidata cliccando sul 

pulsante “Next >”. (Figura 2) 

 

 

 
Figura 1 – File da eseguire per avviare installazione 

 

 



 
Figura 2 - Maschera di conferma installazione guidata 

 

  



• Il passo successivo è quello di indicare la cartella in cui sidesidera installare 

l’applicativo. Il valore di default è 

“C:\Users\Nome_utente\AppData\Local\Istat\ExcelGetSDMXData\” per cambiarlo 

premere il pulsante “Change” (vedi Figura 3). Una volta scelto il percorso, premere  il 

pulsante  “Next >”  

 

Nelle varie fasi della procedura sopra descritta, l’utente avrà la possibilità di annullare l’installazione 

premendo sul pulsante “Cancel” 

 

 
Figura 3 - Selezione cartella di installazione 

  



• Alla richiesta di conferma della installazione (Figura 4) attendere fintanto che il 

pulsante “Install >” non si abilita premendolo per avviare l’installazione. 

• Al termine del processo di installazione Figura 6  premere il tasto “Finish” per 

chiudere la maschera.  

 

 

 

 
Figura 4 - Conferma avvio installazione plugin 

 



 

 

 

Figura 3 - Installazione plugin 

 

Figura 4 - Schermata installazione terminata 

 

 



Inizializzazione  

 

A questo punto il plugin è stato installato ma prima di poterlo utilizzare è necessaria ancora 

una ulteriore fase di inizializzazione così come descritta di seguito. 

 

Per lanciare il plugin è necessario aprire Microsoft Excel. Nella barra in alto, se non vi erano 

preinstallai altri componenti aggiuntivi, viene aggiunto un nuovo tab “Add-Ins
1
” (Figura 7) 

che conterrà il tasto per eseguire il plugin (Figura 8). 

 

 
Figura 5 - Excel 

 

 
Figura 6 - Excel Add-Ins 

                                                           
1
 Nel caso sulla macchina ci sia  installato Office in italiano il tab si chiamerà “Componenti aggiuntivi” 



All’ esecuzione del plugin il sistema avvia l’interfaccia principale (Figura 9) dalla quale è 

possibile aggiungere un web service (“Add a web service”) o accedere alla schermata di 

“Settings” (vedi Figura 10). 

 

 
Figura 7 - Richiesta inizializzazione parametri 

  



Le informazioni che devono essere inserite sono le seguenti: 

• Informazioni riguardanti il Web Service, “Web Service”. 

• Informazioni riguardanti il Proxy, “Proxy Server”. 

• Informazioni riguardanti le directory utilizzate dalla applicazione, “Folders”. 

• Informazioni aggiuntive per l’esecuzione automatica di alcune funzionalità, “Flags”. 

• Opzioni riguardanti l’interfaccia grafica dell’utente, “GUI options”. 

• Informazioni riguardanti la versione del plugin, “About…”. 

 

E’ possibile aggiungere il web service a cui collegarsi premendo il tasto “Add” (Figura 10) e 

riempiendo i campi della form (Figura 11). Premendo il tasto “Test connection” si può 

verificare che l’indirizzo del web service digitato sia corretto. E’ anche possibile selezionare la 

versione del web service SDMX-RI, Intermediate o Ultimate (Figura 12).  Se quanto digitato è 

corretto è sufficiente salvare premendo prima il tasto “Ok” e poi il tasto “Save”. 

 

Per collegarsi al SEP selezionare l’URL premendo il tasto “Get from a list” e scegliere la voce 

“SEP”, l’URL del web service del SEP comparirà criptato. 

 

 
Figura 8 - Maschera gestione Settings 

 



 
Figura 9 - Form aggiunta nuovo Web Service 

 

 
Figura 10 - Connessione al web service 

 

 

 
Figura 11 - Interfaccia successiva alla configurazione parametri 



Accesso all’applicazione 

 

Dopo aver eseguito la fase di “Definizione dei Settings”, durante la quale è stato impostato 

l’indirizzo del web service di default al qual connettersi per richiedere i dati, per eseguire il 

plugin sarà sufficiente cliccare sul ribbon “Get SDMX Data” che si trova nella scheda “Add-

Ins”.  

 

Dipendentemente dalle scelte effettuate, all’avvio si possono verificare uno dei due seguenti 

comportamenti. 

 

a) L’applicativo visualizza l’elenco di quattro operazioni (Figura 14), tra cui quella di 

accedere al web service di default, “Access the default web service”.  

b) Cliccando sulla “X” in alto a destra della schermata iniziale, l’applicativo visualizza 

l’elenco dei web service registrati (Figura 15), tra cui scegliere quello al quale ci si 

vuole connettere cliccando sul pulsante blu . 

 

Avvenuto il collegamento con il Web Service, l’applicativo mostrerà il Category Schema 

contenente tutti i dataset messi a disposizione dal web service selezionato  (Figura 16). 

 

 

 
Figura 12 - Maschera iniziale 
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web service 

di default 
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service 

registrati 



 
Figura 13 – Maschera di scelta web service 

 

 

 
Figura 14 – Category schema 

 

 

  



Interfaccia grafica del Plug-in 
 

L’interfaccia utente di ExcelGetSDMXData è composta da maschera formata da una 

Menubar ed una Toolbar orizzontale (entrambe poste nella parte alta della maschera), 

un’area centrale di navigazione e visualizzazione dei dati ed una Statusbar posta in basso. Di 

seguito verranno ora descritte le vari parti. 

Menu 

 
La menubar si compone di 2 voci principali (File, Action). Queste a loro volta si compongono 

di altre voci così come riportato nella seguente tabella. 

 

Voce 
Menu 

Voce Sottomenu Descrizione 

 

File 

Open Apre una query precedentemente salvata 

Save Salva la query SDMX corrente 

Multiple query Apre la maschera per l’esecuzione di una query 
multipla già esistente 

Settings Apre la maschera per la gestione delle  
impostazioni 

Close Chiude l’applicativo 

 

 

Action 

Extract data to Excel Salva il risultato direttamente in un foglio excel 

Export data Esporta i dati in format  CSV o SDMX 

SDMX Query preview Visualizza la query secondo il formato SDMX 2.0 

Load all concept 
members 

Carica le dimensioni tutte in una volta. 
Disabilitare questa opzione può risultare utile nel 
caso di dataset con enormi  serie di dati. In questo 
caso la dimension member sarà caricata a seguito 

del click su ogni tab. 
Load constrained DSDs Carica solo le DSDs constrained 

View View categories search Visualizza il modulo di ricerca testuale per 
l’albero delle categorie e dataflow 

?  Visualizza informazioni relative alla versione 
dell’applicativo 

Tabella 2 – Lista voci del menu 

 

 

 

 

 

 

 

  

 

Figura 15 – Menubar 



Vicino ad alcune voci compaiono le combinazioni di tasti rapidi (shortcut) che si possono 

premere per richiamare la funzione stessa senza usare il mouse ma usando direttamente la 

tastiera. 

 

Toolbar 

La toolbar raggruppa in forma di icone i principali link alle funzionalità dell’applicativo. 

Premendo le singole icone è possibile richiamare in maniera più semplice le stesse 

funzionalità implementate dall’applicativo e definite nella menu bar sopra descritta. 

La toolbar si compone di due parti (Figura 17). Nella prima vi sono le icone rappresentanti le 

funzionalità dell’applicativo mentre nella seconda è indicato il nome del web service 

correntemente selezionato. 

  

 

 

 

 

 

 

 

 

 

 

Figura 16 - Toolbar 

 

  

Apri query 

Apri query 

multipla 

Salva la query 

SDMX corrente 

Carica anche le 

DSDs “not 

constrained” Settings 

Nome web 

service 

utilizzato 

Salva la query Extract data 

To Excel 

SDMX Query 

editor 

Carica le dimensioni 

tutte in una volta 
Chiude 

applicativo 



Settings 

Alla prima esecuzione del programma, dopo l’installazione, l’utente deve impostare i 

settaggi necessari al corretto funzionamento dell’applicativo impostando i parametri richiesti 

per interrogare il web service. Il tool permette di memorizzare i parametri di connessione a 

più web service e di scegliere di volta in volta il web service dal quale estrarre i dati.   

 

La finestra dei settaggi da impostare viene a richiesta dell’utente. 

Questa maschera si compone di 2 frames affiancati.  

Nel frame di sinistra sono elencate le quattro tipologie di settaggi possibili (Web Service,  

Proxy Server, Folders,  Flags, GUI Options, About) mentre nel secondo sono visualizzati i 

campi da impostare in base alla tipologia selezionata. Di seguito, per ogni gruppo, vengono 

descritti i parametri  

Settings – Web Service 

Questa maschera si compone (Figura 18) dei seguenti campi. 

 
 

Nome campo Descrizione 

Name Nome identificativo il web service 

Description Descrizione del web service 

Web Service URL URL del web service 

User name User name (in caso sia richiesta l’autenticazione) 

Password Password (in caso sia richiesta l’autenticazione) 

Tabella 3 - Campi per la connessione al web service 

 

Selezionando una voce dalla combobox “Name”,  che contiene gli identificativi dei diversi web 

service registrati , i valori degli altri campi (Description, Web Service URL, User name e 

Password ) variano con i valori relativi al ws selezionato. 

E’ anche possibile aggiungere un nuovo web service oppure modificare o cancellarene uno già 

esistente. 

 



 

 

Figura 17 - Maschera Impostazioni collegamento al Web Service 

Su ogni voce si può decidere se modificarne i valori cliccando sul tasto “Modify” o se 

rimuoverla dall’elenco cliccando sul tasto “Remove”. 

Per aggiungere invece un nuovo web service al quale connettersi premere il tasto “Add” e 

compilare il form con tutti i valori necessari definiti in tabella 3. 

Non è possibile cancellare tutti i web service (almeno uno deve essere definito), nè il web 

service di default. Se si ha la necessità di cancellare il web service scelto come default 

l’utente deve prima impostarne un altro come web service di default e poi cancellare il 

vecchio 

N.B. Ogni web service è identificato dal sistema dalla coppia di parametri (Name, URL). 

Quindi una volta salvato non sarà possibile modificarli. Sarà solo possibile, in caso di errore, 

aggiungere quello corretto e eliminare quello errato. 

Settings – Proxy Server 

In questa maschera vanno inserite le informazioni necessarie alla connessione ad un Server 

Proxy
2
 (nel caso in cui l’organizzazione/società utilizzatrice del plugin ne faccia uso). Essa si 

compone ( Figura 15) dei seguenti campi : 

Nome campo Descrizione 

Enable proxy Attiva/disattiva i campi successivi 

Proxy Server URL del Proxy Server 

Proxy Port Numero di porta del Proxy Server 

Proxy User name User name del Proxy Server 

Proxy Password Password del Proxy Server 

Tabella 4 – Campi per la configurazione del Proxy server 

                                                           
2
 Un server proxy è un computer che funge da intermediario tra un browser ed Internet. Consentono di 

velocizzare il caricamento delle pagine Web tramite l'archiviazione di una copia delle pagine più utilizzate. 



 

 

Figura 18 - Maschera impostazioni server Proxy 

Il campo “Proxy Server” e “Proxy Port” contengono rispettivamente l’indirizzo del Server 

Proxy ed il suo numero di porta. 

I campi “Proxy Username” e  “Proxy Password” contengono i dati di accesso da trasferire al 

server proxy specificato, ai fini dell'autenticazione. 

Il check box abilita o disabilita i campi di configurazione (di default questo parametro è 

deselezionato). 

Settings – Folders 

In questa maschera vanno inserite le informazioni necessarie per il salvataggio del file di log 

del sistema (opzionale). Essa si compone (Figura 20) dei seguenti campi : 

Nome campo Descrizione 

Use default user queries path Cartella nella quale vengono salvate le queries dell’utente 

Use default application resources 

(highly recommended) 

Cartella nella quale si trovano i files di Sistema dell’applicativo 

(altamente raccomandata) 

Log file Attiva/disattiva il salvataggio del file di log 

Browse Apre la finestra di dialogo per la gestione dei file di log 

Tabella 5 – Campi di configurazione cartella file log 

L’utente può decidere se far creare o meno un file di log attivando o disabilitando il check 

box presente nella maschera.  In caso di attivazione va inserita, manualmente o 

selezionandola tramite il pulsante “Browse” la cartella
3
 in cui creare il file di Log.  

 

                                                           
3
 Assicurarsi che l’applicativo abbia i diritti di lettura e scrittura sulla cartella 



 

Figura 19 - Maschera impostazioni directory file di Log 

Settings – Flags 

In questa maschera vanno inserite le ulteriori informazioni di configurazione del  sistema. 

Essa si compone (Figura 21) dei campi riportati in tabella 6. 

 

 

Nome campo Descrizione 

Data Language Imposta la lingua in cui mostrare le descrizioni 

Load constrained DSDs Attiva/Disattiva il caricamento di DSDs contrained 

Load all dimension members Attiva/Disattiva il caricamento di tutte le dimensioni 

Show start connection dialog Mostra/Nasconde la finestra delle connessioni all’avvio del 

programma. 

Tabella 6 – Maschera impostazioni Flags 

 

Nel campo “Data Language” va indicato il codice della lingua in cui richiedere di visualizzare 

le descrizioni dei metadati ( al momento ISTAT rende disponibili  i valori  it  per la lingua 

italiana ed  en  per la lingua inglese) 

La casella “Load constrained DSDs” deve essere selezionata se si  desidera caricare 

solamente le DSDs constrained
4
.  Di default questo parametro è selezionato. 

La casella “Load all dimension members” deve essere selezionata se si  desidera caricare 

tutte le dimensioni simultaneamente al momento della richiesta o caricarle singolarmente 

(per maggiore chiarezza vedere paragrafo…) .  Si consiglia di deselezionarlo nel caso in cui si 

stia interrogando dataset che utilizza classificazioni molto grosse (come ad esempio la 

classificazione geografica dei comuni) in quanto il caricamento di tutte le dimensioni  può 

impiegare molto tempo.  Di default questo parametro è selezionato. 

                                                           
4
 DSDs le cui codelist restituite contengono solo i valori effettivamente presenti nel database 



La casella “Use category scheme present in cache memory” deve essere selezionata se si 

desidera salvare su disco il category schema (ad esempio se si vuole evitare di scaricarlo ogni 

volta che viene avviato il web service). Va inoltre indicato il parametro “Updates every … 

days” (valore di default 7) per specificare ogni quanti giorni il category schema viene 

aggiornato dal sistema. Di default questo parametro non è selezionato. 

 

Figura 20 - Maschera impostazioni altri settaggi 



Settings – GUI Options 

In questa maschera vengono impostate le opzioni per l’interfaccia grafica dell’utente. Essa si 

compone (Figura 21) dei campi riportati in tabella 7. 

Nome campo Descrizione 

Show menu bar Mostra/Nasconde il menu 

Show command bar Mostra/Nasconde la barra degli strumenti (toolbar) 

Command bar style Imposta le opzioni della barra degli strumenti 

 

La casella “Show menu bar” deve essere selezionata se si  desidera mostrare la barra di 

menu. Di default questo parametro è selezionato. 

La casella “Show command bar” deve essere selezionata se si  desidera mostrare la barra 

degli strumenti. Di default questo parametro è selezionato. 

Selezionando una voce nella combobox “Command bar style” è possibile cambiare le opzioni 

grafiche della barra degli strumenti: 

• Selezionando la voce “Icons and Text” verranno visualizzate le icone e i testi sulla 

barra degli strumenti. 

• Selezionando la voce “Icons” verranno visualizzate solo le icone sulla barra degli 

strumenti.  

• Selezionando la voce “Text” verranno visualizzati solo i testi sulla barra degli 

strumenti. 

 

 
 

Figura 21 - Maschera opzioni interfaccia grafica utente  

 

 

  



Settings – About…  

 

In questa maschera è possibile visualizzare le Release notes con la lista degli aggiornamenti effettuati 

sulla release installata. 

 

 E’, inoltre, possibile visualizzare la cartella dove è installato il file di configurazione dell’applicativo in 

caso di necessità o problemi al software clikkando sull’apposito link. (SOLO PER UTENTI ESPERTI) 

 

 

 
 

Figura 22 - Maschera About... 

  



Main Page 

 

La schermata principale si compone di una Menubar, una Toolbar ed un’area di 

visualizzazione dei dati (Figura 23). Nell’area di visualizzazione viene mostrato l’albero dei 

category schema presenti e i web services selezionabili, ognuno dei quali è navigabile (Figura 

23.1). I nodi sottolineati rappresentano i dataflows. Cliccando su un nodo, le dimensioni del 

dataflow verranno mostrate nella parte destra della schermata dell’applicazione  (Figura 24 - 

Figura 24.1).  

Come si può vedere dalla Figura 24 le dimensioni appaiono in diverse aree selezionabili 

cliccando sul nome della dimensione. 

Quando l’utente seleziona una dimensione gli vengono mostrati i codici, tra cui scegliere,  

della classificazione a cui questa dimensione è associata. Nel caso in cui per una dimensione 

sia disponibile un solo codice questo sarà selezionato automaticamente e reso non 

deselezionabile. 

In basso a sinistra vi sono tre link per rendere più agevole all’utente la selezione di molti 

codici.  

 “Select All”/”Unselec All” per selezionare/deselezionare tutti i codici in una volta sola e 

“Invert Selection” per selezionare i codici non selezionati e deselezionare quelli selezionati. 

N.B. Per ogni dimensione deve essere selezionato almeno un valore prima di  estrarre i dati.  

In caso contrario il sistema selezionerà automaticamente tutti i valori della dimensione. 

 

Figura 23 - Category schema 



 
Figura 24 - Category schema multiplo 

 

 

Figura 25 - Lista dimensioni 



Per la dimensione temporale la maschera sarà composta da 2 campi: uno per il periodo 

iniziale ed uno per il periodo finale (Figura 26) con una piccola immagine di calendario sulla 

destra. Cliccando sul calendario sarà possibile selezionare la data desiderata  (Figura 27). Di 

default viene preso il massimo arco di temporale possibile. 

 
Figura 26 - Time dimension 

 
Figura 27 - Calendario per la selezione della data 

Nel caso in cui non viene selezionato almeno un valore della dimensione in questione, il 

sistema selezionerà automaticamente tutti i valori della dimensione. Una volta terminata la 

selezione dei valori, le seguenti funzionalità saranno disponibili: 

• Salvare la query SDMX 

• Creare una query Multipla 

• Estrarre i dati 

• Esportare i dati in Excel 

• Visualizzare la query SDMX 

 

Tutte le azioni possono essere eseguite direttamente sia richiamando le voci presenti nel 

Menubar (Figura 16) che utilizzando l’apposita Toolbar (Figura 17) e vengono descritte in 

dettaglio nei successivi paragrafi. 



Open/Save  a query 

Selezionando la voce di menu File->Save o cliccando la specifica icona sulla Toolbar si può salvare la 

query SDMX sul proprio computer. A seguito della comparsa del form Save Query  (Figura 26) sarà 

sufficiente scrivere nell’apposito campo il nome del file in cui sarà salvata e premere il pulsante 

“Save”.  

 

 

Figura 28 - Save Query 

Per recuperare una query salvata precedentemente si può selezionare la voce di menu File->Open o 

la specifica icona sulla Toolbar. Comparsa la form Open Query (vedi Figura 27) in cui è visualizzata la 

lista delle query salvate, l’utente seleziona il nome del file da caricare e preme il pulsante Open. Per 

cancellare una query selezionare il nome del file e premere l’icona (Delete) in alto a destra. 

 

Figura 29 – Aprire una query 

  

Rimuove il file selezionato 

Per aprire la query doppio click sul 

nome del file o selezionarlo e 

premere Open 



Multiple Query 

Selezionando la voce di menu File->Multiple query o cliccando la specifica icona sulla Toolbar, si può 

creare o modificare una query multipla (Figura 28). 

La Query multipla è una query composta a sua volta da più queries salvate in precedenza. 

E’ Possibile aggiungere una nuova query multipla (Figura 29), modificare una query multipla esistente 

(Figura 30) e cancellare una query multipla creata in precedenza (Figura 29). 

 
Figura 30 - Aprire/aggiungere una query multipla 

 
Figura 31 – Creare una query multipla 

Nome della query da selezionere 

Aggiunge una nuova query 

Modifica la query selezionata 

Cancella la query selezionata 

Nome della query da creare 

Queries selezionate che formano 

la query multipla 



 
Figura 30 – Modificare una query multipla 

Extract Data to File 

Dopo la fase di selezione dei valori, l’applicativo genera la richiesta dati da inviare al web service. 

Selezionare quindi la voce di menu “Action->Export Data” oppure premere la specifica icona sulla 

Toolbar od il tasto “ExportData” in basso a destra della figura 24. 

I dati ritornati dal web service possono essere salvati su file in 2 diversi formati: 

• SDMX Generic Data Message (Figura 33). 

• SDMX Compact data message (Figura 34). 

• CVS (common separated values) (Figura 32). 

L’utente può indicare la scelta scegliendo il formato dalla schermata che viene mostrata (Figura 31). 

Selezionando il check box “Export DSD” si può esportare in un ulteriore file la DSD associata al 

dataflow.  

Inoltre solo se si è scelto di esportare i dati in formato CSV, è possibile visualizzare i dati a video in 

una griglia selezionando il check box “View Data”. 

 



 

Figura 31 - Form di selezione del formato dati per l’export 

 

Premuto il pulsante Ok l’utente dovrà indicare il percorso in cui si desidera salvare il file ed il suo 

nome. 

Al termine dell’operazione un messaggio informa dell’avvenuto salvataggio (Figura 35). 

 

Figura 35 – Messaggio fine operazione di salvataggio 

 

 

Figura 32 – Estratto file dati in formato CSV 

 



 

Figura 33 - Estratto file dati in formato SDMX Generic 

 

 

Figura 34 - Estratto file dati in formato SDMX Compact 

  



 

Extract Data to Excel 

Questa funzione permette l’estrazione dei dati nell’ambiente Excel in cui si sta lavorando dopo aver 

effettuato la selezione delle dimensioni semplicemente premendo il pulsante in basso a sinistra 

“Extract Data to Excel” oppure tramite l’icona presente nella toolbar o tramite la voce di menù 

“Action->Extrac Data to Excel”. 

L’utente ha la possibilità di scegliere come visualizzare i dati  tra tre diverse modalità (Figura 35): 

• Time series 

• Dynamic output 

• Separated values 

 

La modalità Time series  visualizza i dati come fossero serie storiche mettendo come prima colonna il 

tempo e sulle restanti colonne affiancate i valori osservati di ogni serie. (Figura 37) 

La modalità Dynamic Output visualizza le dimensioni in un’altra maschera, suddividendole in tre 

pannelli differenti. Questa modalità da all’utente la possibilità di poter cambiare l’ordine delle 

dimensioni tramite il drag & drop sul pannello della fiancata e il pannello della testata. Questo 

modalità viene affrontata in maniera più dettagliata nel capitolo “Dynamic Output”. 

La modalità Separated values visualizza i dati mettendo in colonna le tutte le dimensioni , poi il valore 

osservato ed infine gli attributi nell’ordine in cui sono stati descritti nella DSD. (Figura 38) 

Oltre al formato di visualizzazione in aggiunta l’utente può richiedere di estrarre anche le modalità 

delle code list associate alle dimensioni e agli attributi. Per far ciò sarà sufficiente selezionare la check 

box “Extract DSD”. (Figura 35). Verrà quindi aggiunto un foglio con la lista delle dimensioni/attributi e 

per ognuno di questi  le diverse modalità che può assumere (Figura 36) 

I dati estratti verranno inseriti direttamente in fogli Excel che saranno chiamati con il nome del 

dataset scelto. Nel caso si desideri effettuare più richieste per uno stesso dataset , l’applicativo 

nominerà i diversi fogli sempre con il nome del dataset seguito da un numero casuale. (Figura 39) 

Infine, nel caso in cui noi ci siano dati da estrarre l’applicativo lo segnala con un messaggio (Figura 40) 

 

 

Figura 32 – Maschera di selezione del formato di visualizzazione dei dati 



 

 

Figura 33 – Code list associate alle dimensioni/attributi 

 



 

Figura 34 – Dati visualizzati in formato “Time series” 

 

 

 

Figura 35 - Dati visualizzati in formato “Separated values” 

 

 

 

 



 

 

Figura 36 - Foglio Excel con 3 worksheet diversi per uno stesso dataset (12_323) 

 

 

 

Figura 37 - Messaggio informativo di assenza dei dati. 

 

  



Ricerca delle categorie e dei dataflow 

La versione 2.6.0.1 dell’ExcelGetSDMXData è stata dotata della possibilità di ricercare le categorie ed 

i dataflow attraverso il loro nome o parte di esso. 

All’apertura dell’applicativo viene visualizzata un campo per l’immissione del testo da ricercare nella 

parte bassa della form principale.  

 

Figura 38 - Ricerca categorie e dataflow 
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Inserita la parola e premendo INVIO verrà visualizzata la lista dei risultati 

 

Figura 39 - Risultato della ricerca 

In nero verranno visualizzati i nomi delle categorie trovate, in blu i nomi dei dataflow. 

Selezionando un elemento della lista e premendo il bottone con la freccia per l’apertura l’elemento 

ricercato: 

• categoria:  verrà aperto l’albero alla categoria selezionata 

• dataflow: verrà aperto il dataflow selezionato e caricati i metadati strutturali relativi. 



 

Figura 40 - Apertura categoria 

 

Figura 41 - Apertura dataflow 

 



Nel caso si volesse chiudere il modulo di ricerca si può premere il tasto apposito di chiusura a destra 

del modulo stesso o premere la sequenza di tasti CTRL+F. 

Nel caso si volesse aprire nuovamente il modulo è possibile farlo attraverso il menù principale alla 

voce View->Category search, oppure premendo la sequenza di tasti CTRL+F. 

 

Figura 42 - Apertura modulo ricerca 

  



Query multipla Time series in One Sheet 

La versione 2.6.0.1 dispone di una nuova modalità di esportazione su Excel: Time Series in One Sheet.  

Tale modalità permette di visualizzare su uno stesso foglio Excel i risultati di una query Multipla. I 

dataset verranno affiancati sul piano orizzontale e la dimensione tempo (Time Period) sarà 

l’elemento in comune presente sulla fiancata sinistra. 

La nuova modalità è presente nel modulo dell’esecuzione delle query multiple ed è disponibile come 

nuovo formato di output. 

 

Figura 43 - Time series in One Sheet 



Una volta selezionato il formato verrà visualizzato un campo di immissione testo per permettere 

all’utente di inserire il nome con il quale desidera venga denominato il nuovo foglio Excel. Il sistema 

propone di default il nome della query multipla selezionata. 

 

Figura 44 - Nome nuovo foglio Excel 

 
Figura 45 - Esecuzione 

Indicare il nome del foglio Excel  che si 

desidera creare 



Come accennato all’inizio del paragrafo il risultato della nuova modalità di output prevede i dataset 

affiancati e la dimensione tempo come dimensione comune. 

 

 
Figura 46 - Risultato 

  

Risultato dei differenti 

dataset 



SDMX Query Editor 

Se si desidera visualizzare, modificare ed eseguire direttamente la query SDMX (ottenendo come 

risultato un file SDMX Generic) , generata automaticamente dall’applicativo a partire dai valori scelti 

per le dimensioni, è sufficiente selezionare la voce di menu Action->SDMX Query Editor. Fatto ciò si 

aprirà una nuova finestra modale (Figura 38) che conterrà il codice xml, che viene inviato al web 

service per la richiesta dei dati. Se si desidera premendo l’icona in basso a sinistra la query verrà 

copiata in memoria per poter riutilizzarla in seguito. Nell’editor, inoltre, è possibile scrivere o 

incollare una query dati SDMX non generata dall’applicativo. L’eventuale esecuzione della query 

restituirà un file SDMX Generic e sarà inviata al web service attivo al momento dell’apertura della 

form del SDMX Query Editor. 

Per chiudere la finestra premere il tasto “Close”. 

 

 

Figura 47 - Finestra SDMX Query Editor. 

 

 

 

Figura 48 - Menu SDMX Query Editor 
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Dynamic Output 
Dynamic Output è un modulo aggiuntivo dell’ExcelGetSDMXData che permette all’utente di gestire 

l’output dei dati attraverso un semplice e avanzato strumento grafico. 

L’utente può gestire la disposizione dei dati sul foglio Excel, cambiare la grafica delle celle, salvare o 

caricare dei template personalizzati prima del processo dati. 

 

 

Figura 49 – Utilizzo del Dynamic output 

  

2. Clicca col pulsante sinistro del 
mouse su Extract data to Excel 
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mouse su Dynamic Output 



Interfaccia del software 

Il Dynamic Output dispone di una semplice interfaccia composta dal pannello strumenti e Quattro 

pannelli personalizzabili. 

 

Figura 50 - Interfaccia principale Dynamic Output 

Panello strumenti  

 

Il pannello strumenti è composto da cinque sezioni: 

• Application panel (pannello applicazioni) 

• Template panel (pannello template) 

• Output options panel (pannello output) 

• Dimensions graphic panel (pennllo dimensioni grafiche) 

• Data grid graphic panel [Observations] (pannello data grid – osservazioni) 

  



 

Application panel 
L’ Application panel l’esportazione dati in Excel. E’ compost dal pulsante Excel e dal pulsante Search. 

 

 Excel Button  

Questo pulsante serve per eseguire l’esportazione dati nel foglio Excel. 

 Search Button  

Questo pulsante permette di sfogliare le cartelle del proprio hard-disk, alla ricerca di file 

Excel creati in precedenza. 

 

 

Template panel 
Il Template panel permette all’utente di gestire il XML che compone la struttura grafica. Esso è 

composto dal pulsante Save, dal pulsante Load e dal pulsante Favorite. 

 

 Save Button 

 Questo pulsante permette all’utente di salvare la “struttura grafica
5”  in un file XML. Il file del 

template personalizzato, ha una struttura specifica definita a livello di Query. 

 Upload Button 

 Questo pulsante permette all’utente di salvare una specifica struttura grafica in un file XML. 

Se il file XML ha una struttura differente da quella della query in uso, il Sistema avviserà l’utente con 

un messaggio. Il messaggio elencherà gli eventuali elementi grafici che non verranno caricati. 

 Favorite Button 

 Questo bottone permette all’utente di impostare il template di default. Il file XML del 

template di default, è definite a livello di pannelli e quindi non ha una struttura specifica e livello di 

query. Il template di default viene caricato automaticamente dal sistema, durante l’avvio del 

programma. 

 

 

 

 

 

 

 

 

 

 

                                                           
5
 Per struttura grafica si intende la disposizione delle dimensioni sui diversi pannelli e il loro formato grafico 



Output options panel 
Il pannello Output options panel permette all’utente di scegliere le modalità di visualizzazione dati 

nel foglio Excel. Esso è composto da tre elementi. 

 

  Show names. Questo pulsante gestisce la visualizzazione dei dati. Quando la casella è 

selezionata i nomi delle dimensioni vengono mostrate sul foglio Excel, in caso contrario quando non è 

selezionata vengono mostrati i codici delle dimensioni. 

 

Starting column e starting row sono i valori che compongono la cella dalla quale il Sistema inizierà a 

scrivere I dati sul foglio Excel. 

 Column. Questo selettore numerico gestisce la Colonna di partenza del foglio. Il valore è 

impostato di default e il valore minimo sono impostati a 1. 

 

 Row. Questo selettore numerico gestisce la Riga di partenza del foglio. Il valore è impostato 

di default e il valore minimo sono impostati a 1. 

N.B. Il programma inizia a scrivere dati dopo una riga vuota per rendere più leggibile il foglio. 

Dimensions graphic panel 
Il pannello Dimensions graphic permette all’utente di personalizzare la struttura e la grafica della 

parte superiore della foglio, della testata della tabella e della fiancata della tabella. Esso è composto 

dal pulsante Background color, dal pulsante Text color, dal pulsante Text font e dai pulsanti 

Alignment. 

 

 Background color Button 

 Questo pulsante permette all’utente di cambiare il colore di sfondo della label. 

 Text color Button 

 Questo pulsante permette all’utente di cambiare il colore del testo della label. 

 Text font Button 

 Questo pulsante permette all’utente di scegliere il carattere del testo della label. 

 Alignment to left Button 

 Questo pulsante permette all’utente di allineare il testo della label a sinistra. 

 Alignment to center Button 

 Questo pulsante permette all’utente di allineare il testo della label al centro. 

 Alignment to right Button 

 Questo pulsante permette all’utente di allineare il testo della label a destra. 

  



 

Data grid graphic panel [Observations] 
Il pannello Data grid graphic permette all’utente di personalizzare la struttura e la grafica dei valori 

delle osservazioni. Esso è compost dal pulsante Background color button, dal pulsante Text color, dal 

pulsante Text font, dai pulsanti Alignment, dal pulsante Borders cells e dal pulsante Settings. 

 

 Background color Button 

 Questo pulsante permette all’utente di cambiare il colore di sfondo della cella. 

 Text color Button 

 Questo pulsante permette all’utente di cambiare il colore del testo della cella. 

 Text font Button 

 Questo pulsante permette all’utente di scegliere il carattere del testo della cella. 

 Alignment to left Button 

 Questo pulsante permette all’utente di allineare il testo della cella a sinistra. 

 Alignment to center Button 

 Questo pulsante permette all’utente di allineare il testo della cella al centro. 

 Alignment to right Button 

 Questo pulsante permette all’utente di allineare il testo della cella a destra. 

 Border Button 

 Questo pulsante permette all’utente di scegliere lo stile del bordo della cella. 

 Settings – number format 

 Questo pulsante mostra/nasconde il pannello del  

formato numero (tabella 1, figura2).  

 

 

Number format 

Decimal position 

Questo parametro gestisce il numero di 

decimali dopo la virgola. Il valore di default è 

due e il range di valori va da 0 a 4. 

Thousand separator 

Questa checkbox gestisce il separatore di 

migliaia. Se selezionata il programma mostrerà 

il separatore di migliaia, in caso contrario non lo 

mostrerà. Questa casella è selezionata di 

default. 

  



 

Panels layout 

 

Il panels layout è compost da quattro pannelli: 

 

• Parte superiore 

• Testata 

• Fiancata 

• Griglia dati            Observations panel 

 

Tutti gli elementi dei pannelli dimensioni, possono essere selezionati individualmente con il pulsante 

sinistro del mouse, o possono essere selezionati insieme premendo il pulsante sinistro del mouse a il 

tasto Ctrl. 

Ogni pannello relativo alle dimensioni, dispone del tasto multi-selection. Questo pulsante permette 

all’utente di selezionare tutti gli elementi di un pannello in una volta sola tramite il click del mouse. 

 

 Tutti gli elementi sono selezionati 

 

Figura 51 - Table header 

  

Dimensions panels 



 

 Tutti gli elementi sono deselezionati  

 

Figura 52 - Table header elementi deselezionati 

E’ possibile personalizzare la grafica di questi elementi tramite il pannello Dimensions graphic  o il 

pannello smart Dimensions graphic  

 

  

Questo pannello è posizionato nella sezione Tools panel. 

 

  

Questo pannello viene utilizzato quando l’utente clicca col pulsante destro del mouse sopra 

l’elemento desiderato. 

 

  



Parte superiore 
Il pannello Sheet top-side (parte superiore del foglio) contiene tutte quelle dimensioni che 

dispongono di un solo valore. 

 

 

Figura 53 - Sheet top-side 

 

Questi elementi hanno l’allineamento fissato alla sinistra del foglio e non possono essere trascinate 

negli altri pannelli. 

Le dimensioni appaiono nella parte alta del foglio Excel. 

 

  



Testata 
La Testata contiene le dimensioni che hanno più di un valore (la dimensione temporale viene 

automaticamente caricata nella Fiancata). Questi elementi sono trascinabili e possono quindi essere 

spostati sul pannello della fiancata. Le dimensioni appaiono nella testata della tabella dati. 

 

Figura 54 - Table header 

Fiancata 
La Fiancata contiene le dimensioni che hanno più di un valore. La dimensione temporale viene 

automaticamente caricata in questo pannello. Questi elementi sono trascinabili e possono quindi 

essere spostati sul pannello della testata. Le dimensioni appaiono nella fiancata della tabella dati. 

 

Figura 55 - Table left-side 

 

  



Griglia dati 
La Griglia dati contiene I valori delle osservazioni. Nel pannello del Dynamic Output però vengono 

mostrati dei dati di esempio. I dati reali saranno visibile nel foglio Excel in uscita. 

 

Figura 56 - Table data grid 

 

E’ possibile personalizzare la grafica delle celle attraverso il pannello Data grid graphic, posizionato 

nella Tools panel. 

 

I valori delle osservazioni appaiono nella griglia della tabella del foglio Excel. 

 

 

Layout del foglio Excel 

 

Figura 57 - Layout del foglio Excel 

  



Processo dell’applicativo 

 

Esecuzione del modulo 

Premere il pulsante Extract data to Excel dopo aver selezionato il data flow, poi cliccare sull’elemento 

Dynamic output. 

 

Figura 58 - Esecuzione 

  



 

 

Personalizzazione della struttura grafica 

Dopo il caricamento del flusso dati, l’utente può personalizzare la struttura dati. 

 

Figura 59 - Personalizzazione visualizzazione 

 

Caricare o creare un template 

L’utente può caricare un template esistente cliccando sul pulsante Load , oppure può cambiare il 

layout grafico usando il pannello Dimensions graphic (per i pannelli Parte superiore, Testata e 

Fiancata) e il pannello Data grid graphic (per la Griglia dati). 

 

Figura 60 - Personalizzazione 

  



Un esempio di personalizzazione del colore di sfondo degli elementi dimensione. 

 

Figura 61 - Personalizzazione 

Colore dello sfondo personalizzato. 

 

Figura 62 - Personalizzazione sfondo 

  



Un esempio di personalizzazione del colore di sfondo degli elementi osservazioni. 

 

Figura 63 - Esempio di personalizzazione 

Colore dello sfondo personalizzato. 

 

Figura 64 - Personalizzazione sfondo 

Terminata la personalizzazione grafica, l’utente sarà in grado di impostare l’attuale struttura grafica 

come template di Default. Il template di default verrà caricato automaticamente ogni volta che il 

Dynamic Output verrà avviato. 

 Premere il pulsante Favorite per impostare il template attuale come Default template. 

 



 

Personalizzazione del template 
L’utente può spostare un element dimensione da un pannello a un altro. Questa opzione è 

disponibile solo per i pannelli Testata e Fiancata. 

 

Figura 65 - Template 

Gli elementi possono essere trascinati da un pannello a un altro. 

 

 

  

TIME_PERIOD 

REF_AREA 



 

 L’utente può salvare il layout di una query specifica usando il pulsante Save. Questo pulsante 

salver il layout con una specifica grafica e una specifica disposizione delle dimensioni. 

 

Figura 66 - Salvataggio template 

  



 

Esportazione dati 

 Per avviare l’esportazione dati in un foglio Excel, premere il pulsante Excel. Una progress bar 

mostrerà lo stato del processo. 

 

Figura 67 - Esportazione in Excel 

Una finestra pop-up informerà che l’esportazione dati è state completata. 

 

Figura 68 - Esportazione effettuata con successo 

 



Chiusura dell’applicativo 

Una volta terminate l’esportazione dati, l’applicazione si chiuderà automaticamente mostrando il 

foglio Excel. 

 

Figura 69 - Chiusura applicativo 

 

 Per chiudere manualmente l’applicazione, cliccare sul pulsante Close e l’utente tornerà alla 

schermata del plugin Excel Get SMDX Data. 

 

Figura 70 - Chiusura applicativo 

 


